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1 Introduction

1.1 What dj does.

You can make music playlists by hand but this is time consuming and you may find that you keep choosing 
the same tracks.

You can tell your music player to shuffle play all your music tracks but you probably aren't that fond of 
most of them and find yourself listening to an awful lot of dross.

What dj does is to randomly choose tracks to make a playlist giving preference to your higher rated tracks. 
You'll still hear the low rated ones from time to time. Who knows: some of them might grow on you.

Once you've set things up, you'll be able to use dj to make a fresh playlist in just a few seconds. No longer 
will you find yourself listening to the same songs over and over just because it's too much of a faff to 
change them.

1.2 Using different music players

If you want to listen to music on a computer that already contains a copy of your music library, dj can make 
a playlist that a player such as iTunes, Windows Media Player or Rhythmbox can play. You may also be 
able to play it on a network-connected smart TV or sound system (Section 6.5).

If you want to copy the chosen tracks to a stand-alone player such as an iPod, tablet or phone, or to a USB 
thumbdrive or SD card, dj can do this too.

1.3 What dj expects:

• That all your music files are in subfolders of a single folder on your computer.

• That the subfolders and files are named in a useful way, e.g. according to artist and song title.

You can still use dj even if these conditions aren't met but it won't be as easy or convenient for you to set up 
the ratings and make playlists.

1.4 Rating the tracks

No program can know which tracks you like and which ones you don't. You're going to have to tell it and 
that will be time-consuming.

dj lets you use your favourite spreadsheet to set the ratings. This has many advantages:

• Spreadsheets are designed to make it quick and easy to input data. You do this from the keyboard 
instead of having to click on icons for each track you want to rate.

• You can use all the features of your favourite spreadsheet, such as sorting tracks, filling in blocks of 
data and searching and replacing.

• You won't have to learn a new program to do these things.

• You'll be able to use your ratings outside of dj too if you wish.

1.5 Tidying up your music library

If you buy and rip compilation and “Best of” CDs, you're likely to have several copies of many tracks. dj 
has features that help to track these down. You can use dj to delete the duplicates or just tell it to omit them 
from its playlists.
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1.6 Using dj with other media

You can use dj with other types of media files, e.g. photographs (see the -e option).

Unfortunately this isn't likely to be so easy because the file names probably won't mean much to you. 
Rating them will be a much slower process and dj's matching functions may not be any use at all.

1.7 What computer can dj run on

Ready-built versions of dj are available to be downloaded, installed and run on Intel/AMD based Windows 
or Ubuntu systems (Chapter 2).

This guide includes detailed instructions for these two systems. If you have a different Linux version, 
you can follow the Ubuntu instructions but may have to make some changes.

As a simple command-line program, dj can be compiled to run on other systems (Section 8.3). For example, 
it has been compiled and run successfully on an ARM based Debian system.
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2 Installing dj

2.1 Finding your music library

Before you go any further, it's worth confirming that you can find your music library and are likely to be 
able to use it in the way you want.

Windows 7

Click , then Music on the right hand side of the box that appears.

Windows XP

Click , then My Music on the right hand side of the box that appears. If you see files and folders 
related to your music collection (e.g. folders named for various artists), you know that the collection is 
stored at My Documents\My Music.

Ubuntu

Click  on the Launcher. The Nautilus file manager opens. Click Music on the left hand side.

All systems

If you see files and folders related to your music collection (e.g. folders named for various artists), you 
know that this is where the collection is stored. The rest of this guide assumes this is the case and refers to 
your media folder as Music (Windows 7), My Documents/My Music (XP) or ~/Music (Linux).

If your collection is somewhere else, you'll need to track it down and refer to its folder instead.

Open nested folders in succession until you see some of the actual music files. If they end with .mp3 and are 
shown as Type: MP3 Audio, you'll be able to play them on any player. If they are a different type (e.g. .m4a 
Type: MPEG-4 audio), dj can still work with them but they may only play on certain devices such as an 
iPod.

2.2 Using the command line

dj is a command-line program but it isn't that scary to use.

Windows 7

Click . Type Command into the Search programs and files box, then click Command Prompt in the list 
that appears. A Command Prompt box quite similar to the one shown below for Windows XP appears.

Windows XP

Click , then All Programs (at the bottom of the box). Move the mouse pointer over Accessories, 
then click Command Prompt in the box that appears.

The Command Prompt window displays a command line prompt (circled). It shows which folder you're in 
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(C:\Documents and Settings\<your user name> (blurred out here) on XP, C:\Users\<your user name> on 
Windows 7).

This is your home folder. With Windows 7, Music is a subfolder in your home folder. With Windows 
XP, My Music is a subfolder of My Documents which in turn is a subfolder of your home folder.

Ubuntu

Click   on the Launcher and type term into the search box. Click on Terminal.

The Terminal displays a command line prompt (circled). It shows your user name (blurred out here) and 
which folder on the system you're in (~ represents your home folder and Music is a subfolder of this).

All systems

Type in commands as shown later (a single line at a time), then press RETURN to execute the command 
you just typed.

2.3 Installing dj

Windows

Download dj.exe from drenewydd.com/programs/dj/dj.exe, clicking Save, (not Run). Click Music in the 
Save As box that appears, then click Save.

With Windows XP, click My Documents, then My Music in the Save As box.

The program is saved in your Music or My Music folder ready for you to use. 64 bit Windows can 
run 32 bit programs such as dj.exe.

Ubuntu

If you're using a 64 bit version, download dj64 from drenewydd.com/programs/dj/dj64, If you're using a 32 
bit version or you aren't sure, download dj32 from drenewydd.com/programs/dj/dj32,

You may need to install the ia32-libs package to run 32 bit programs such as dj32 on a 64 bit system.

Use the following commands to make dj into a system-wide program that will be easy for you and any other 
users to use:

cd ~/Downloads
mv djxx dj
chmod 755 dj
chown root:root dj
sudo mv dj /usr/bin

Replace  djxx with dj32 or dj64 depending on which one you downloaded.

If you (understandably) don't fully trust dj, use the following commands instead to move dj to your Music 
folder, keeping it limited to your own use only:

cd ~/Downloads
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mv djxx dj
chmod 755 dj
mv dj ~/Music

2.4 Checking that it works

Windows 7

At the command prompt (Section 2.2), type the following command, then press RETURN:

cd Music

Windows XP

At the command prompt (Section 2.2), type the following command, then press RETURN:

cd “My Documents\My Music”

The double quotes are needed because of the spaces in the folder names.

Linux

At the command prompt (Section 2.2), type the following command, then press RETURN:

cd ~/Music

All systems

Type the following command and press RETURN:

dj

On a Linux system, if you've installed dj in your Music folder you'll need to type ./dj instead here and  
everywhere else in this guide.

You should see

*********************************************** 
*                  dj                         * 
*                                             * 
* Utility to make random playlists from music * 
*   file collection giving regard to track    * 
*   ratings. Also helps to find and remove    * 
*           duplicate track files.            * 
*                                             * 
*                Version  1.0                 * 
*                                             * 
* Syntax:                                     * 
*  dj [options] media_folder [playlist size]  * 
* where                                       * 
*  media_folder contains media files/folders  * 
*  size is the wanted total playlist target   * 
*   files size in bytes, (e.g. 2G)            * 
*                                             * 
* Options:                                    * 
*  -a enables auto-exclusion of matched files * 
*  -f enables auto-fixing of filenames        * 
*  -g reduces escaping of filenames for Excel * 
*  -h shows this help screen and exits        * 
*  -k appends new tracks to existing playlist * 
*  -m selects file matching mode              * 
*  -n copies media files with numeric names   * 

8 2 Installing dj



*  -q enables matching files in same folder   * 
*  -y suppresses interactive questions        * 
*                                             *
*  -bFILE sets copy playlist    (DEST/dj.m3u) * 
*  -cDEST copies selected files to DEST       * 
*  -dATTRS deletes files with any of ATTRS    * 
*  -eEXTS sets extensions for media files     * 
*  -iRATING sets default for unrated tracks   * 
*  -lRATING sets min RATING for playlist  (1) * 
*  -oATTRS requires ATTRS for playlist        * 
*  -pFILE sets playlist file (media_f/dj.m3u) * 
*  -rFILE sets a ratings file      (./dj.csv) * 
*  -sATTRS skips matching of ATTRS files(DES) * 
*  -tTHRSH sets threshold for matching   (15) * 
*  -uRATING sets max RATING for playlist  (5) * 
*  -vTHRSH sets threshold for leveling   (33) * 
*  -wEFFECT sets EFFECT of ratings        (5) * 
*  -xATTRS excludes ATTRS from playlist (DEX) * 
*                                             * 
* dj is released under GPL V3 - it is free to * 
* use. For info and source code, please visit * 
*               drenewydd.com                 * 
*********************************************** 

If you're using Windows, you may get an error message saying that msvcp100.dll isn't installed. For 
32 bit Windows, go to http://www.microsoft.com/en-us/download/details.aspx?id=5555 to download 
and  install vcredist_x86.exe. For 64 bit Windows, go to http://www.microsoft.com/en-
us/download/details.aspx?id=14632 to download and  install vcredist_x64.exe.

2.4 Checking that it works 9

http://www.microsoft.com/en-us/download/details.aspx?id=14632
http://www.microsoft.com/en-us/download/details.aspx?id=14632
http://www.microsoft.com/en-us/download/details.aspx?id=5555


3 Getting started

At the command prompt (Section 2.2), type the command needed to change to your music folder if needed 
(Section 2.4), then type the following command and press RETURN:

dj .

Be sure to include the dot in the command. It says to look for music in the current directory (we are 
assuming dj is installed in your music folder). If you're in a different folder, you'll need to replace . 
with the path to your music folder here and in subsequent commands.

Remember, you might need to type ./dj instead. 

You see something like this:

Scanning media folder... 
  7002 old and current tracks: total current size 29509354232 
Checking list for tracks no longer present... 
Writing ratings file... 
Done - Visit drenewydd.com for support and information 

These messages mean the following:

Scanning media folder...

dj is compiling a list of all tracks that it finds in the folder that you specified. Once it has done this, it 
shows the number of tracks that it found and their total size in bytes.

As supplied, dj can handle a maximum of 65535 tracks (see Section 8.4). If there are too many tracks,  
some will be ignored.

Checking list for tracks no longer present...

This will be explained later.

Writing ratings file...

dj is writing a new ratings file containing a list of all the tracks that it found. By default, this is called 
dj.csv and is in the current folder (e.g. Music or My Documents\My Music).

You can specify a different folder and/or file name using the -r option. See Chapter 4.

3.1 The ratings file

Open the new ratings file dj.csv using a spreadsheet such as Excel or LibreOffice.

Open your music library as in Section 2.1. Find dj.csv and click or double click it to open it as a 
spreadsheet.

Unfortunately, although the Polaris Office that comes with many Android devices can open the file, it  
can't save any changes that you make to it.

You see a row in the spreadsheet for each track that dj found.

Column A shows the path to and name of the track file. If the files and folders are named sensibly, 
you'll see the artist and song name here.

Column B is reserved for the track ratings. At the moment it is completely blank

Column C is reserved for attributes. These will be covered in Chapter 5.

Column D shows the size in bytes of the track.

Column E is reserved for match numbers. These will be covered in Section 3.3.
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With LibreOffice, you might find that Column A takes up the full screen width and it isn't obvious 
how to see the other columns as well. Right click on A above the column and choose Column Width... 
in the menu that appears. Type in a smaller width and click OK.

You can start rating some tracks. Put a number between 0 and 5 in column B for each track that you want to 
rate. E.g. put

5 for a favourite track that you want to hear as often as possible

4 for a track that you really like but not quite as much

3 for a track that you quite like

2 for a track that leaves you cold

1 for a track that you don't like at all but might like to hear very occasionally

0 for a track that you never want to hear (you could use an attribute instead)

Don't try to rate all your tracks now. It's likely to take too long. Just do some of your favourites and leave 
the other ratings blank.

Don't agonise over the ratings. Changing a rating by 1 doesn't have that drastic an effect.

Save your changes to dj.csv, then save a backup copy, e.g. as dj.xls. That way you won't lose your ratings if 
dj somehow trashes dj.csv.

LibreOffice may ask you to confirm which format to use when saving the file. Click Use Text CSV 
Format.

3.2 Making a playlist

Type the following command and press RETURN:

dj . 100M

You see something like this:

Reading ratings file... 
Scanning media folder... 
  7002 old and current tracks: total current size 29509354232 
Checking list for tracks no longer present... 
Writing ratings file... 
Selecting tracks... 
  25 tracks selected: average rating 3.21
Levelling playlist... 
Writing playlist file...
Done - Visit drenewydd.com for support and information 

Reading ratings file... indicates that, this time, dj finds the existing ratings file (dj.csv) and 
reads it in as an initial tracks list.

Note that dj ignores anything in columns D (size) onwards.

The order of the tracks in the file doesn't matter. You can freely use the Sort Data function of your 
spreadsheet, e.g. to put all your unrated tracks together. Just be sure to select all columns (at least 
columns A-C) before sorting so that the ratings and attributes stay with the right track files,

Scanning media folder... dj again scans the media folder, filling in the sizes for tracks that were 
read in from dj.csv and adding any new tracks that it finds to the list.

Note that 1 GByte is 1000000000 bytes and 1 MByte is 1000000 bytes so the total size of the library 
(29509354232 bytes) is approximately 29.5 GBytes.

Checking list for tracks no longer present... dj looks for any tracks from the ratings 
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file that weren't found in the media folder (e.g. because you've deleted them). Unless you had assigned a 
rating or attributes, these tracks are removed from the list.

Writing ratings file... the file (e.g. dj.csv) is rewritten with the file sizes updated, any new 
tracks added and unrated missing ones removed. All existing ratings and attributes are included in the file.

Selecting tracks... dj is selecting tracks for a playlist whose target size is 100MBytes. Section 8.1 
explains how this is done. The number of tracks selected is shown along with their average rating.

A default rating of 3 is used for tracks that you haven't rated yet. It's quite possible that, if you only 
gave high ratings to a few tracks, none of them will have been chosen. The -i option (Chapter 4) lets 
you change the default rating.

 Assuming the music plays at 160 Kbps, a 100 Mbyte playlist translates to around 

100000000×8
160000×60

=83.3 minutes of music (there are 8 bits in a byte and 60 seconds in a minute). 1  

GByte would play 10 times as long – more than enough to last for a working day and 3 GByte should  
last for a working week.

However, if you request a playlist that's larger than about 10% of the size of your music library, 
you'll find that your preferences start having less effect. In the extreme case where you request a 
playlist equal to or larger than the library, it will contain almost the entire library and won't be 
much different from just shuffle-playing the whole thing.

Levelling playlist... It's likely that there will be places in the playlist where, just by chance, there 
are several high rated tracks one after another and other places where there are several low rated tracks in 
succession. Dj looks for this and swaps tracks in the playlist to even things out.

Writing playlist file... dj is writing the playlist as dj.m3u in the media folder. You can use this 
file with a player such as iTunes, Windows Media Player or Rhythmbox.

You can use the -p option to specify a different playlist file location and/or name.

You can use the -c option to specify a location (e.g. a music player or USB thumbdrive that you've 
connected to your computer – see Section 6.3). As well as writing the playlist file, dj copies the 
selected tracks there after deleting any existing tracks.

You can use the -k option to keep and add to existing tracks.

You can use the -c and -p options together to write a standard playlist file as well as copying the 
tracks. The playlist file can be useful in identifying any problem tracks (e.g. strange recordings) that 
you hear. 

3.3 Finding duplicate tracks

Type the following command and press RETURN:

dj -m . 10G

Most of the messages you see are the same as last time but there are some changes:

Matching tracks... dj is comparing file names to identify likely duplicate tracks. After a delay, the 
total number of files so identified is shown.

The delay depends on the speed of your computer and is proportional to the square of the number of 
tracks in the list. Doubling the number of tracks increases the delay by 4 times.

The -t option lets you trade off the number of false matches against the number of missed ones.

Matching songs with one word titles are likely to be missed.
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You don't see Selecting tracks... or Levelling playlist.... The list is sorted so that 
matched tracks are together, then a playlist is written containing the matches in the same order.

It makes sense to specify a large target size for the playlist here (e.g. 10G) so it can include all the 
matched tracks.

Open dj.csv again as a spreadsheet. You'll see that matched tracks are grouped together at the top and that 
each group has a different match number in column E.

You can review the matches and set attributes in column C as required (Chapter 5). It's helpful to load the 
playlist into a player on your computer so you can listen to the matched tracks while you're doing this.

Likely situations are:

• Some tracks are matched falsely. E.g. they may be the same song by different artists or different 
songs by the same artist (this tends to happen if the artist name is several words long). You may 
want to set S as an attribute on one of them so that dj won't try to match the track in future.

• Some matches are different recordings of the same song by the same artist (e.g. live and studio 
recordings). Listening to the playlist may help to identify these. You may want to give a low rating 
to one of the versions or even set X as an attribute so it will be excluded from playlists entirely.

• Some matches are different edits of the same song by the same artist (e.g. shortened or radio 
versions) and some are completely identical. You should choose one of the tracks as the one you 
want to use. The sizes may be helpful or you may have to listen. Set D or E attributes for the others, 
depending whether you think you might want to delete the track file itself (see -d option in Chapter 
4) or just exclude it from playlists (see -x option).

Tracks with D or E attributes set will also be skipped in future by default (-s option) when dj is 
matching tracks. If you deal with all the existing matches now, you won't need to use the -a option 
with its associated delay to avoid duplicate tracks in your playlists and it'll be easier to spot any new 
duplicates after you add tracks.

If dj has already matched several tracks and then finds a match between any of them and another 
track, it adds it to the same group of matches. Some other tracks in the group may bear no direct 
resemblance to the added one but grouping them all together turns out to be safer and less confusing 
than any alternative approach.

Also see the -q option.

This is a good time to rate most of your tracks. Remember to keep a backup copy of the spreadsheet.

3.4 Adding tracks

When you add more tracks to your music library (e.g. by ripping a new CD) then run dj again, it adds the 
new tracks to the end of the list and will use the default rating (-i option) for them. You can open the 
rating file as a spreadsheet, go to its end to see the new tracks, then rate them.

You can use the -m option to see if any of the new tracks are duplicates.

Remember to update your backups.
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4 Options in detail

-a (Auto-exclude) enables matching of track file names and excludes all but the first of any group of 
matched files from the playlist. Because the matching process is slow and may make false matches, it's 
worth checking matches and setting attributes (Section 3.3) instead of using this option.

-b [PATH/]FILE lets you specify the name and location of the playlist file for copied tracks when the -c 
option is also used. E.g. -c Play -b Play/playlist.m3u tells dj to copy the playlist track files to 
the Play folder in the current directory and also write a playlist as playlist.m3u there. The default if you 
don't use -b is dj.m3u in the same folder specified by the -c command.

-c DEST (Copy tracks) copies the playlist track files to the DEST folder. This is a quick way to put them 
on many music players (Section 6.3).

-d ATTRIBUTES (Delete track files). After asking for confirmation (see the -y option), this deletes track 
files from your library that have any of the specified attributes. E.g. -d D deletes files with the D attribute 
set. 

-e EXTENSIONS (set media track file Extensions) tells dj to look for files with any of the specified 
comma-separated extensions. E.g. -e jpg,jpeg tells dj to look for photo files with .jpg or .jpeg exten-
sions instead of the default music file extensions (aac, .aiff, .alac, .flac, .mp3, .m4a .m4p, .ogg, .wav or 
.wma)

-f (Fix track file names).  After asking for confirmation (see the -y option), this automatically renames 
any folders or track files in your library whose names include characters that are incompatible with the FAT 
file system used on some older computers and many thumbdrives and music players.

You may prefer to use the -n option to overcome problems copying files to a music player.

-g reduces escaping of file names in the ratings file so only \ and “ are escaped (Section 8.2). This is a good 
choice if you are using Excel as the names will be a bit easier to read.

-h (Help) causes the help screen to appear. The screen also appears if you run dj without specifying a 
media folder.

-i N (Initial rating) sets the default rating for new or unrated tracks. E.g. -i 0 gives them a zero rating. If 
you don't use the -i option, the default rating is 3.

-k (Keep previous tracks) appends the selected tracks to the existing playlist and, if the -c option is also 
used, copies them to the specified folder without deleting tracks already there. You can use this when 
running dj several times to select tracks from different libraries although they won't be shuffled or levelled 
fully.

-l N (Lowest rating) sets the minimum rating that a track must have to be considered for the playlist. E.g. 
-l 3 excludes files with ratings less than 3. By default, the minimum is 1 so that tracks rated 0 are 
excluded.

-m (Match mode). This option enables matching of track file names and makes a playlist consisting of all 
tracks that are matched in the same order as they appear in the rating file. See Section 3.3.

-n (Numeric file names). When used along with the -c option, the files copied to the specified folders are 
given numeric names (e.g. 000001.mp3, 000002.mp3) instead of their file names in the library. This helps to 
prevent some music players reordering them and can also avoid problems with FAT file systems and some 
file name characters (see -f option).

-o ATTRIBUTES (Only select). This excludes track files from the playlist unless they have at least one of 
the specified attributes. E.g. -o pq will require files to have either the lowercase p or q attribute (or both) 
to be considered.

-p [PATH/]FILE (Playlist file) lets you specify the path (containing folders) and name of the playlist 
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file. E.g. -p Music/playlist.m3u tells dj to write the playlist to a file named playlist.m3u in the 
Music folder in the current directory. The default if you don't use -p is dj.m3u in the specified media library 
folder.

-q allows matching of files in the same folder (when -a or -m is also used). Without this option, dj 
assumes that they are ripped from the same CD and can't be duplicates.

-r [PATH/]File (Ratings file) lets you specify the path (containing folders) and name of the ratings 
file. E.g. -r Documents/ratings.csv tells dj to read and update a file named ratings.csv in the 
Documents folder in the current directory. The default if you don't use -r is dj.csv in the current directory.

-s ATTRIBUTES (Skip attributes). When used with the -a or -m option, this tells dj to skip media files 
having any of the specified attributes when matching files. E.g. -s ESX will skip any files with an upper-
case E, S or X attribute. If you don't use the -s option, files with any attribute D, E or S are skipped.

-t NN (match Threshold) sets the threshold for files to be matched when used with the -a or -m option. 
The default is 15. A higher value (e.g. -t 25) produces fewer true matches and many fewer false ones. A 
lower value (e.g. -t 10) produces more matches, lots of them false.

-u N (Upper rating) sets the maximum rating that a track can have and still be considered for the playlist. 
By default, this is 5 but you can set it lower (e.g. -u 4) if you get fed up with your favourite tracks.

-v NNN (leVelling threshold) sets the threshold where dj starts swapping tracks in the playlist to level it. 
The threshold is in 1/100 of a rating step. The default is 33 (1/3 of a rating) so that levelling is done if the 
average rating somewhere in the playlist deviates by more than 1/3 of a rating step from the overall playlist 
average. E.g. if the average for the entire playlist is 3 but the average for some successive tracks is below 
2.67 or above 3.33, tracks will be swapped around. Using -v 50 would change these thresholds to 2.5 and 
3.5 allowing more successive high or low rated tracks while -v 500 would disable levelling entirely. 

-w NN (rating Weighting) controls how much dj takes track ratings into account when making a playlist. 
The default weighting is 5. A higher weighting (e.g. -w 8 or -w 10) results in more high-rated and fewer 
low-rated tracks in the list. A lower weighting (e.g. -w 3) has the opposite effect and -w 0 causes dj to 
ignore the ratings entirely within the range set by -l and/or -u. See Section 8.1.

-x ATTRIBUTES (eXclude attributes).  This excludes track files from the playlist if they have any of the 
specified attributes. E.g. -x pq will exclude files with either the lowercase p or q attribute (or both). If you 
don't use the -x option, files with attributes D, E and/or X are excluded. 

-y (Yes) suppresses the confirmation steps for the -d and -f options. This may be useful if dj is called 
from a batch or script file with either of these options.

Options a, f, g, h, k, m, n, q and y don't have associated values. You can group them together, e.g. 
-gmq.

Other options must either be on their own or the last in a group. The value can usually follow 
immediately or after a space. E.g. -agqw7, -agqw 7, -agq -w7 and -agq -w 7 are 
equivalent. However, if you use ~ to represent your home directory in Linux, you must have a space 
in front of it (e.g. -r ~/dj.csv)

If the value itself includes a space, it needs to be enclosed in double quotes. E.g. 
-r “My Documents/dj.csv”.

If you want to suppress default attributes, you can put a space and another dash after the option. E.g.  
-x - completely suppresses exclusion of files, including those with D, E and X attributes.
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5 Using attributes

Each track in the ratings file can be given up to 10 attribute letters (spreadsheet Column C). The letters don't 
need spaces between them and upper and lower case attribute letters are different.

Upper case attributes are intended for the following uses:

Use D to indicate a track that you are considering deleting from your library using the -dD option. 
Until you do so, the track will be excluded by default from playlists and the matching process.

-dD also deletes the tracks from the ratings file. If you have multiple copies of the library and want 
to delete the same tracks from all of them, make a separate copy of the ratings file for each library 
before you use -dD. 

Use E to indicate a duplicate (or very similar) track that you want to exclude from your playlists or 
matches but don't want to delete from your library.

Use S to indicate a track that dj tends to match falsely. By default, this skips the track during the 
matching process but but doesn't exclude it from playlists.

Use X to indicate a track that you want to exclude from playlists for some other reason (you could give 
it a zero rating instead).

You can freely use lower-case letters a-z for your own classifications. You can then use the -o and -x 
options to make playlists for special purposes.

For example, suppose you're a Leonard Cohen fan and have lots of his songs which you've marked 
with attribute l. Some might have other attributes too, e.g. a track might have lS as its attributes in 
Column C.

You want to make an upbeat playlist for a party. Use -xlDEX to exclude the Leonard Cohen songs 
along with other tracks marked with D, E or X.
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6 Playing the playlist

6.1 Playing on your computer

Use dj to make a playlist of suitable size. This guide assumes it is dj.m3u in your music folder.

Windows7

Click , then click Music. Find dj.m3u in the window that opens. Right-click on it and choose Play with 
Windows Media Player. The tracks start playing in order.

Windows XP

Click , then click My Music. Find dj.m3u in the window that opens. Click or double-click it. 
Windows Media Player starts playing the tracks in order.

Type: M3U file appears when you move the mouse cursor over dj.m3u.

You may need to untick Shuffle in the Play menu, then click on the first track in the list.

Ubuntu

Start Rhythmbox. Click Music > Playlist > Load from file.... Click Music at the left of the File Browser 
window, then find dj.m3u in the main pane, select it and click Open.

dj.m3u shows up under Playlists at the left of the Rhythmbox window. Make sure it's selected. The playlist 
tracks appear in the main window. Select the first one and start playing it. The rest of the tracks play in 
order.

After you make a fresh playlist, right-click dj.m3u at the left side of Rhythmbox, choose Delete, then use 
Music > Playlist > Load from file... to select and load the fresh version. 

6.2 Copying to an Apple device

Apple devices have a complex system of folders. It isn't practical to use the -c option to copy a 
playlist directly to them.

Use dj to make a playlist of suitable size. This guide assumes it is the default dj.m3u in your music folder.

Windows

Plug in your device. iTunes should start automatically. If you don't see the device on the left side, click 
View > Show Sidebar.

In iTunes, click File > Library > Import Playlist....  The File Open dialogue appears. Click Music on left 
side, then look for dj.m3u in the main pane and double-click to open it.

Type: M3U file appears when you move the mouse cursor over dj.m3u.

Click the device on the left hand side, then click Music above the main pane. Make sure the Sync Music box 
is ticked. Just below, choose Selected playlists, artists, albums and genres.

Under Playlists, make sure dj is ticked, then click Apply.

Wait until synchronisation is complete, click the button to eject the device, then unplug it.

Ubuntu

Follow Section 6.1 to start Rhythmbox and load the playlist.

Plug in your device. After a short delay, it should appear on the left side of the Rhythmbox window.

A box may pop up asking what to do when you plug in the device. Choose Do Nothing.
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Right-click the device and click Properties. On the Sync tab under Sync Preferences, click the right-arrow 
next to Music. Clear all tickboxes except those next to Music and to the playlist (dj.m3u). Click Close.

Near the top of the Rhythmbox window, click Sync to Library. Once this is no longer greyed out, click 
Eject alongside and unplug the device.

Both systems

Select the playlist in the device to hear the tracks in the correct playlist order.

On an iPod Shuffle, hold down the centre button on the remote control in the headset lead. When you  
hear the word “playlist”, release the button, then immediately click it once.

After using dj to make a fresh playlist, you need to delete the existing playlist in iTunes or Rhythmbox. 
Load the new one as before and sync the device again.

6.3 Copying directly to other devices

With a device such as a thumbdrive, just plug it in.

The method also works with older Android devices but they are a bit more complicated. Plug the device into 
the computer and see if an option to share files appears on its screen. If so, select it. Otherwise, try going to 
Settings > Wireless and Networks > USB utilities. Tap the Connect storage to PC button and follow the 
instructions on the device.

Newer Android devices only use MTP. They don't appear as disk drives when you plug them in and 
you'll need to use the method in Section 6.4.

Windows

Click  or , then click Computer. You should see the thumbdrive or device as a new disk drive. 
The drive letter is shown (e.g. F:). Make a note of it.

You may see two new disk drives: one for the device itself and another for its external SD card.

Click to open the device. Look for or create a subfolder on it to hold the music files. Note the path to the 
subfolder.

Use dj to select and copy files for a new playlist to your device in one step. E.g. suppose the drive letter is 
F: and the folder is mp3. Use -c F:/mp3 as an option.

For a thumbdrive or SD card, you generally don't need to make a subfolder. Just use e.g. -c F:

See Section 7.3 to find out how to create a batch file that makes this easy to repeat in future.

Copying the files over the USB connection may take some time. Once dj is finished, click  or  at the 
bottom right of the screen and click Safely Remove.

Ubuntu

Click  on the Launcher. Nautilus opens. You should see your device as a new item at the top left (with 

 next to it).

You may see two new items: one for the device itself and another for its external SD card.

Place the cursor over the one you want to use. Its mount point (e.g. something like /media/1160-418D) 
appears. Make a note of it.

Click to open the device. Look for or create a subfolder on it to hold the music files. Note the path to the 
subfolder.

Use dj to select and copy files for a new playlist to your device in one step. E.g. suppose the mount point is 
/media/1160-418D and the folder is mp3. Use -c /media/1160-418D/mp3 as an option.
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For a thumbdrive or SD card, you can generally don't need to make a subfolder. Just use e.g. -c 
/media/1160-418D

See Section 7.3 to find out how to create a script file that makes this easy to repeat in future.

Copying the files over the USB connection may take some time. Once dj is finished, click  next to the 
device(s) in Nautilus to unmount the device(s).

Both systems

On an Android device, tap the Disconnect storage from PC button on your device.

Unplug or disconnect the device.

Many devices require you to select the new dj playlist to hear your tracks in the right order. Some 
simple devices don't use playlists and may start playing them in alphabetic or some other unwanted 
order. The -n option can help here.

Your Android player may be bug-infested. If you have problems turning off shuffle play, try clicking 
on the album artwork for the track that is playing, then click on . It may still insist on playing the 
playlist in reverse order but this isn't a big problem.

6.4 Two-step method

Make a temporary folder on your computer and have dj make a playlist of suitable size for the device. Use 
the -c option to have dj copy the files it has selected to the temporary folder.

Plug the device into your computer and follow the procedure in Section 6.3 to look for and open it.

You don't need to note the drive letter or mount point when you use this method.

Use your computer's normal copy-and-paste or drag-and-drop method to copy the files that dj put in the 
temporary folder to the thumbdrive or device.

This should include the playlist file (usually dj.m3u in the same folder unless you used the -b 
option).

Once the files are copied, use the steps in Section 6.3 to eject or safely remove the thumbdrive or device 
and play the playlist.

Newer Android devices only support MTP. If you're using Windows XP, you may need to install extra  
software on the computer to work with them. If you're using Ubuntu, you may find that MTP support 
is unreliable.

Instead of plugging an Android device into your computer, you may be able to use Bluetooth to 
transfer the files.  Unfortunately this can be very slow.

If the temporary folder is in your music library, be sure to delete its contents after copying them. 
Otherwise, the next time you use dj, it will scan the folder and might choose some of the tracks it 
contains for the next playlist. It deletes the folder contents before copying and it may show error 
messages because now it can't find some of the files it wants to copy.

6.5 Using dj with DLNA

DLNA (Digital Living Network Alliance) allows client devices such as smart TVs and internet radios 
connected to your local (e.g. home) network to access media files such as music, photos and videos stored 
on your computer.

Windows 7 includes a DLNA server which you can enable by going to Control Panel > Network and 
Sharing Center. Click Choose homegroup and sharing options in the window that opens, then tick the box 
alongside Stream my pictures, music and videos to all devices on my home network.
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Ubuntu doesn't include a DLNA server but you can add one through the Software Center. I haven't had 
much luck with Mediatomb but minidlna mostly works. Install it, download the sample minidlna.conf from 
drenewydd.com/programs/dj/minidlna.conf, modify it and save it as /etc/minidlna.conf, then restart the 
computer.

Look for <computer_name> and <user_name> in the sample minidlna.conf and change them to suit 
your system.

Client devices vary. Look for options such as uPnP, Music, Photos or Videos then see if your computer 
shows up. If so, you should be able to choose individual music tracks, photos or videos from your computer.

Make sure you don't have anything embarrassing in your Music, Pictures or Videos folders: 
whatever you have there will show up where children or your maiden aunt may see them!

Minidlna can be a bit temperamental. If you're using it and don't see your computer on the client 
device, try restarting the computer or manually starting minidlna with sudo minidlna.

Most devices also show Playlists under Music. When dj puts the dj.m3u playlist in your Music folder, it 
should show up as one of the playlists so that you can start it playing on the client device.

Simply running dj again refreshes the playlist. On a Linux system, you can set up a cron job to do 
this every night. Talk about a No Repeat Guarantee!
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7 Hints and tips

7.1 Tags

dj doesn't look at the contents of the music files. When the -c option is used, it just copies the files 
unchanged.

Most players look for and use tags embedded in the files. This is how they are able to show the artist and 
song title for many tracks even when you've used the -c and -n options.

The player may want to reorder the tracks, e.g. by artist. You should be able to overcome this by telling it to 
play the dj playlist that the -c option includes with the copied tracks. 

7.2 Multiple rating files

You can use the -r option several times to specify multiple rating files (e.g. for a shared playlist when 
several people are taking a car trip together). Each track is given the highest rating from the multiple files 
and the attributes from the first file only. None of the rating files are updated. 

7.3 Using batch/script files

To save having to remember useful options and to make things quick and easy, you can create batch or 
script files that use dj for things that you do frequently. For example, you could create a file that makes a 
new playlist and copies its files to your music player or phone.

Because of the iTunes lock-in, things are never going to be this easy with an iPod or iPhone.

Windows

Windows uses batch files. You can use a text editor such as Notepad to create them. The file only needs to 
contain the command or commands you want it to carry out, e.g.: 

dj -anc F:/MyDevice -p djMyDevice.m3u -w7 ~/Music 1G

Save the file, e.g. as MyDevice in the same directory as dj.exe and dj.csv. Then, whenever you want to put a 
fresh playlist on the device, just plug it in, start Command Prompt, cd to the directory and type MyDevice.

In this case, dj will make a new 1GByte playlist, save it in the current directory as djMyDevice.m3u 
and copy the music files to a thumbdrive that's plugged into the computer and shows up as 
MyDevice.

Ubuntu

Linux uses script files. You can use a text editor such as gedit to create them. Here's an example:

#!/bin/sh 

./dj -anc /media/MyDevice -p djMyDevice.m3u -w7 ~/Music 1G

The first line tells Linux that it's a script file. The second line uses dj to do the work.

Save the file, e.g. as MyDevice in the same directory as dj and dj.csv. Use chmod 750 MyDevice to 
make it executable. Then, whenever you want to put a fresh playlist on the thumbdrive, just plug it in, start 
Terminal, cd to the directory and type ./MyDevice.
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8 Advanced topics

8.1 Playlist track selection algorithm

After rewriting the ratings file, dj shuffles the tracks in the list into a random order. It then works its way 
through the list, deciding whether each track should be added to the playlist.

A track will not be added if any of the following applies:

• It's already in the playlist.

• It isn't in the library (its size is zero).

• It has an attribute which says it should be excluded.

• The -o option was used and it doesn't have any of the specified attributes.

• Its rating is less than that specified with the -l option (less than 1 by default).

• Its rating is higher than that specified with the -u option.

• Adding it would make the playlist larger than the size you specified.

• If the -a option was specified, it has matches and isn't the first track in the group of matches.

Provided none of these conditions apply, dj uses the track's rating, the rating weighting (-w option) and a 
random number to decide whether to add it to the playlist. The probability of the track being added is as 
follows:

Weighting Rating
5 4 3 2 1 0

0 100.00% 100.00% 100.00% 100.00% 100.00% 100.00%
1 100.00% 81.25% 66.02% 53.64% 43.58% 35.41%
2 100.00% 66.02% 43.58% 28.77% 18.99% 12.54%
3 100.00% 53.51% 28.64% 15.32% 8.20% 4.39%
4 100.00% 43.36% 18.80% 8.15% 3.53% 1.53%
5 100.00% 35.55% 12.63% 4.49% 1.60% 0.57%
6 100.00% 28.91% 8.35% 2.41% 0.70% 0.20%
7 100.00% 23.44% 5.49% 1.29% 0.30% 0.07%
8 100.00% 19.14% 3.66% 0.70% 0.13% 0.02%
9 100.00% 15.23% 2.32% 0.35% 0.05% 0.01%
10 100.00% 12.50% 1.56% 0.19% 0.02% 0.01%

Once all the tracks have been considered, dj reduces the weighting by 1 and repeats the process. This ends 
when a pass through the list is made without adding any further tracks.

When the list is nearly full, only the very shortest tracks are likely to fit. You may find that they end 
up in most playlists.

If dj has made several passes through the tracks list, the tracks near the end of the playlist will tend to be 
lower rated than those near the start. This is for two reasons:

• The highest rated tracks are likely to have been chosen during the first pass: those rated 5 are 
certain to have been chosen then.

• The weighting is less during later passes.

Dj randomly shuffles the playlist to overcome this tendency.
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8.2 Escaping in folder and file names

When dj writes the ratings file, it puts double quotes (“) before and after the folder and file name (spread-
sheet column A) for each track. These ensure that, when the file is opened in a spreadsheet or when dj reads 
it in again, the folder and file names are handled correctly and not split up.

However, there could still be problems if the folder and file name itself contains double quotes. Addition-
ally, LibreOffice doesn't automatically put the double quotes if you make changes to the ratings and save 
the file.

You can tell LibreOffice to use double-quotes but it's easy to forget to do this. Excel is smarter and 
automatically knows to use them.

To avoid problems, dj always replaces “ anywhere in a folder or file name with \2. It also replaces \ with \\.

This process is known as escaping.

Unless the -g option is used, the following changes are also made to avoid problems with LibreOffice:

, is changed to \c

; is changed to \s

' is changed to \1

TAB characters are changed to \t

SPACE characters are changed to \_

dj undoes any of these changes that it finds when it reads the preference file back in.

This is regardless of whether the -g option is used or not.

8.3 Building dj from source

Download the source code from drenewydd.com/programs/dj/dj.zip. Unzip the file and copy or extract its 
contents to a new folder on your computer.

Windows

Go to http://www.microsoft.com/visualstudio/eng/downloads#d-2010-express to download and install  
Microsoft Visual C++ 2010 Express.

This development system is free but you will need to register with Microsoft to continue using it after 
30 days. 

Start  Microsoft Visual C++ 2010 Express and click File > New > Project from existing code. A dialogue 
box opens. 

Check that Visual C++ is selected under What type of project would you like to create, then click Next >. 

Click Browse..., select the new folder containing the source files and click Select folder. 

Give the project a name (e.g. dj) and click Next >. 

Under Project type: choose Console application project. 

Click Finish. The project is created. 

Change the dropdown box at the top from Debug to Release. 

Check dj in the Solution Explorer on the left side is highlighted. If not, click it. 

Click Project > Properties. The dj Property Pages dialogue opens. Click the arrow to the left of Configura-
tion Properties on the left hand side. 

Make sure General is highlighted below. Click Character Set in the main pane then click the downarrow on 
the right. 
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Choose Use Unicode Character Set from the drop-down list. 

Click Linker on the left hand side. Make sure General is highlighted below. Click Enable Incremental 
Linking in the main pane, then click the downarrow on the right. 

Choose No (/INCREMENTAL:NO) from the drop-down list, then click OK. 

Click Build > Build solution. 

There should now be a Release folder in the project folder containing dj.exe. This is the executable you just 
built. Copy it to your Music or My Documents/My Music folder.

Linux

On the command line, cd to the new folder and type make.

If this doesn't work or you get errors, use sudo apt-get install build-essential to 
install the compiler and required libraries.

Note that the makefile calls the compiler with a -DUNIX option. This defines UNIX, controlling 
compilation of the source files to suit Linux instead of Windows.

Copy or link the resulting dj to a convenient location (e.g. ~/Music).

8.4 Structure of the source code

Dj is written in C and C++. Advantages are:

• The program is compact, fast and efficient.

• It is self-contained, not relying on other software such as a Java Virtual Machine.

• It is easily rebuilt for other computer architectures.

• The languages are widely known and well supported.

The code is comprehensively commented but you might want to note the following (especially if you want 
to reuse parts of it in your own project):

• dj.cpp contains main(). It also sets MAX_TRACKS to 0xffff (65535) – you can change this and 
rebuild if you want.

• trackslist.cpp and trackslist.h provide a class to hold the list of tracks with their ratings, attributes, 
size, etc.

• wordslist.cpp and wordslist.h provide a class to hold the list of words found in the track file names 
with an occurrence count for each one. This might be useful in other projects too.

• options.h provides a class that parses the command line and makes the parameter and option values 
available to the rest of dj. It could be replaced to provide a graphical interface.

• dj uses a mix of Windows and Linux library functions (whichever looks cleaner). The missing 
version is implemented in compat.cpp and compat.h. For example, when building for Windows, 
these provide an implementation of the Linux ftw (File Tree Walk) function.
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